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Preface

This documentation explains how to install and use the sample applications that are provided
with NaturalONE. It is organized under the following headings:

Installing the Sample How to install the sample applications from the welcome page.
Applications
Hello World Application The Hello World application is the preferred starting point for using

NaturalONE. This is a simple sample which demonstrates a Natural
project which implements a Hello World application by using Natural
for Ajax.

Travel Approval Application  This sample demonstrates a Natural project which implements an Ajax
application for a business travel approval system.

Natural for Ajax Demos A collection of small Natural for Ajax samples which demonstrate how
to use the different controls and how to bind them to Natural server-side
processing.
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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://documenta-
tion.softwareag.com.

Product Training

You can find helpful product training material on our Learning Portal at https://learn.software-

ag.com.

Tech Community

You can collaborate with Software GmbH experts on our Tech Community website at https://tech-
community.softwareag.com. From here you can, for example:
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About this Documentation

Browse through our vast knowledge base.

Ask questions and find answers in our discussion forums.

Get the latest Software GmbH news and announcements.

® Explore our communities.

® Go to our public GitHub and Docker repositories at https://github.com/softwareag and ht-
tps://hub.docker.com/publishers/softwareag and discover additional Software GmbH resources.

Product Support

Support for Software GmbH products is provided to licensed customers via our Empower Portal
at https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

® Download products, updates and fixes.

® Search the Knowledge Center for technical information and tips.

" Subscribe to early warnings and critical alerts.

Open and update support incidents.

Add product feature requests.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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2 Installing the Sample Applications

When you start NaturalONE for the very first time, you will see a so-called “Welcome” page. From
this page, you can install several sample applications for NaturalONE. If the welcome page is not
visible, you can open it as described below.

/) Important: Before installing a sample application, open the NaturalONE perspective and

wait until the startup of the local Tomcat server has completed. When you start NaturalONE
for the very first time, this will take some time. In the Console view, you can keep track of
the Tomcat status.

~ To install a sample application
1  From the Help menu of Eclipse, choose Welcome.

The welcome page appears.




Installing the Sample Applications

warkspace - Software AG Natural ONE = O X
| File Edit Navigate Search Project Run  Window Help

N-HRIVBiH-0-QU-iBy/~if-fl-oF e Q 8k
51 ] welcome x o= 8

S Software AG Visit the Software AG Community Website

NaturalONE

| NaturalONE is an all-in-one modemn development
environment that allows application developers to create

| new Ajax- and service-based programs as well as maintain

| and improve existing applications using standard open-
source Eclipse. This allows developers to write robust,
enterprise-scale, modern applications quickly and easily.

~

@ Open the NaturalONE Perspective
(%) Documentation

(&) Hello World application

| ZemMeizs™ [ J|

2 Inthe NaturalONE list box, scroll down until you see the following links for the sample ap-
plications.

) Hello World application
& Travel Approval application
&) Database access application
&) Matural for Ajax demos

& Natural for Ajax responsive tutorial

3 Toinstall a sample application, click the corresponding link in the NaturalONE list box.

The sample application is copied to your workspace. The Project Explorer view is automatically
shown, containing the new sample application as a new project.

¢ Tip: To get more space for the views of the Natural perspective, close the welcome

page.
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Installing the Sample Applications

4  After installing a sample application, it is recommended that you rebuild the project using
the Clean command from the Project menu.

If the Build Automatically command in the Project menu is currently not active, make sure
that Start a build immediately is switched on in the Clean dialog box.
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3 Hello World Application
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Hello World Application

About the Sample Application

The Hello World application is the preferred starting point for using NaturalONE. This is a simple
sample which demonstrates a Natural project which implements a Hello World application by
using Natural for Ajax.

Installing the Sample Application

Install the sample application by clicking Hello World application on the welcome page. A new
project named "NaturalONE Hello World Sample Application" will then be shown in the Project
Explorer view. See also Installing the Sample Applications.

Starting the Sample Application

You start your first Natural application by executing the program HELLO-P.NSP in the SAMPL40NE
library.

~ To start the sample application

1 Inthe Project Explorer view, expand the project NaturalONE Hello World Sample Applica-
tion.

| Note: By default, the environment to which a Natural project pertains is shown next

to the project name. For the sample applications, the environment name is "natural-
runtime". This is the local Natural runtime which enables you to execute your applica-
tions without having to use a remote development environment. The number in paren-
theses which is also shown next to the project name indicates the number of Natural
libraries in this project. This is part of the so-called label decoration.

There are two folders:

* Natural-Libraries
Natural-Libraries contains the folder SAMP4ONE. This is the Natural library for this
sample application.

SAMP40ONE contains the folder SRC. This folder contains the Natural source files.

HELLO-A.NSS8 is the Natural adapter, that is, the Natural interface to the Ajax page.
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Hello World Application

HELLO-P.NSP is the Natural program which implements this simple Hello World applic-
ation.

® User-Interface-Components
User-Interface-Components contains the folder samplecomponents which in turn contains
the folder xml.

helloworld.xml contains the Ajax page layout. This page layout is defined with the Layout
Painter, which is invoked from the context menu with Open With > Layout Painter.

For detailed information about the Natural for Ajax technology, see Natural for Ajax.

2 Select the program HELLO-P.NSP, invoke the context menu and choose Run As > Natural
Application.

The output is now shown.

(@ Matural /O 532 = 0O
Hello World! 2
"Say Hello!”
rlnput Area e

Your name
'Output Area -

3  Enter your name in the Input Area and choose the Say Hello button.

Your name is now shown in the Output Area.

Sample Applications 1
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4 Travel Approval Application
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Travel Approval Application

About the Sample Application

The Travel Support System (this is the name that you can see on the screen when executing the
application) is a small sample application for NaturalONE. As a sample application, its focus is
to show NaturalONE functionality rather than being a full-fledged travel support application.

The Travel Support System (TSS) allows you to request and approve business trips. Flights, hotels
and even more external information such as cell phone expenses or car rentals can be entered with
the trip request. For the destination, weather information can be queried. A manager can do both,
request own trips as well as approve trips that have been requested by employees. After the
manager has approved single or multiple requests, the manager can print an itinerary or receive
the itinerary as a PDF file.

The usage of the travel approval application is described below.

Prerequisites

In order to use the sample application, Adabas Version 6.1.9 or above must be installed and started.

Installing the Sample Application

Install the sample application by clicking Travel Approval application on the welcome page. A
new project named "Travel" will then be shown in the Project Explorer view. See also Installing
the Sample Applications.

Defining the Use of an External Web Browser

You will now make sure that the sample application is executed in an external web browser and
not in the internal web browser.

> To define the use an external web browser

1  From the Window menu, choose Preferences.

2 Expand the General node and select Web Browser.

The following page appears.
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Travel Approval Application

3

P
-
ﬂ Preferences

type filter text

a General

Appearance
Capahilities
ComparefPatch
Content Types
Editars

Keys

Metwark Connections
Perspectives

search

Security

Service Policies
Startup and Shutdown
Web Browser
Workspace

» Ant
» Data Management

m

YWeb Browser

Add, remove, or edit installed web browsers.,

The selected web browser will be used by default when web pages are opened,
although seme applications may always use the external browser.

@ Use internal web browser

) Use external web browser

External web browsers:

[7] Internet Explorer

Default system web browser

[ Restore Defaults] ’

Apply ]

Lo JI

Cancel ]

Starting the Sample Application

Select the Use external web browser option button and choose the OK button.

You start the sample application by executing the program LOGIN.NSP in the TRAVEL library.

> To start the sample application

N =

1. Natural-Libraries
2. TRAVEL
3. SRC

Expand the following nodes:

In the Project Explorer view, expand the project Travel.

Scroll down until you see the program name LOGIN.NSP.

Select LOGIN.NSP, invoke the context menu and choose Run As > Natural Application.

The sample application is executed. Since you have specified so in the preferences, it is executed
in an external browser window.

Sample Applications
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Travel Approval Application

f"I1lt|.r..-'.-'lr.ll.-=IrllJ:-I.:ﬂl]ﬂIII_-'r.l:-lml.ur-:l_"wn'li:l_"'EI.urP.E[SF'nue HPAGEURL = /cisnal ural MatLogonhtmilBxciPara - Windows Inbernel Explorer !IE B
ﬁﬂrm'. Ipcathst tjStartC15PagaTRAGELR o e =) ’ -
Fil= Edk ‘iew Faworites Took Help

Fawortes i fér.__._, Fad Sihas nmmpﬁm B | Web Slice Galery =
[ bt fllocabost-Boa0/cnaturaliservist St art CIPage. | | P = B - 0 o - Page~ Sofeby - Took - -

Fricday, « Febroary 2011 - 9:15 AM WS = ™| Tutorial | Exit TSS
Travel Support System

Please select a User name

Smith Garh.., (exampla) bl

¥ Web access Powsred by Hatural OHE

L)) Cpen selection boxfor use F7 for active help and select & user/manager { == ),
Do [ [T [ & Local intrarst ia v [Riee -

Logging in as an Employee for Requesting a Business Trip

You will now log in as an employee (with limited rights) and request a business trip.

~ To log in as an employee

1 Inthe Please select a User name dialog, type "A" over the name that is currently shown in
the drop-down list box.

The drop-down list box opens, displaying the names of all employees and managers which
start with the letter "A". This information comes from the Adabas demo database.
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Travel Approval Application

Please select a User name

w
SBELLAMN KEPA =
SCHIESON ROBERT

= ADAM SIMOME (manager)
ADKIMSOMN JEFF
ADKINSOMN PHYLLIS

= ADKIMSOMN HAZEL (manag
ADKINSON DAVID

ﬂI]KTNHﬂN CHARI TF | Jﬂ
1 3

2 Select the name "ADKINSON DAVID".

Please select a User name

ADKIRSOMN DAVID w

I Enter Mew Request |

3  Choose the Enter New Request button.

The following screen appears. Here, you will enter your travel request.

Friday, 4 Febrsary 2011 - 9:31 4M You're logged in as DAVID ADKINSON Loa-cut -
PR CR  Travel Support System
o | select 2 flight =
Dwparture information
i IC'rt',',Cantr\' x| |Pick a2 date »
Retum informatian > ‘ S,
= | City Country =| [Pick a date » w
[I_Il.i-'.'.'u Expemses) F W
_ _ | Select & hotel =l
2 [Travelpetails 3| Total cost o B

]
X< Add other expenses from
5 a.csy file

[m . Upload .csv

f

| Selet & City for farecast  ¥)
Washanghon 450 —

s Baijing 11°C

@ Start by filing Travel reason, departure and retumn info
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Travel Approval Application

Entering a Travel Request with Flight and Hotel Information

You will now enter and submit your travel request. This includes the following information:

= City and date for departure.

City and date for return flight.

Flight number.

Hotel name.

~ To enter a travel request

1  In the Reason text box, enter the reason for your travel plans. For example:

INew Travel Request

Reszon

I have a series of meetings with customers regarding our new
product MaturslONE,

2 Under Departure information, open the drop-down list box.

Departure information

& | City,Country *| Pick adate w
W ashington,USA,
_4s |Beijing,China Pick adate »

Frankfurt, Germany
Paris, France

— |Toronto,Canada
Melbourne sustralia L |
Moscow ,Fussia
AmSterdam MNederland
WiennaAustria

o R R—.

3  Select Toronto,Canada.

4  Click on Pick a date which is shown to the right of the departure information.

5 In the resulting Date Input dialog, select the desired date for your flight to Toronto (for ex-
ample, February 21, 2012).

6  Under Return information, open the drop-down list box.
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Travel Approval Application

Departura inforrmation

& | City, Country x| 20120221 »

Return information

A | City, Country | Pick adate =

W ashington,USa,
Beijing,China
Frankfurt,Garmany 3 |
Paris,France

Toronto,Canada
Melbourne australia —
Moscow ,Russia
amsterdam,Mederdands |
Vienna Austria

7 Select Beijing,China.
8  Click on Pick a date which is shown to the right of the return information.

9  In the resulting Date Input dialog, select the desired date for your return flight from Beijing
(for example, February 28, 2012).

Departure information

< |Toronto,Canada x| 2012-02-21 &

Feturn informnation

~ | Beijing,China x| 2012-02-28 ~

You have now entered the basic information needed to make travel plans. Next, you will book
a flight and a hotel.

10 Under Flight Booking, open the drop-down list box.

Select a flight ;I
British &irways Flight: # 7684 ,
Lufthansa Flight: &£ 1, 928
BMI Flight: # 98032 , 469
Singapore Airlines Flight: # 694
Austrian Airlines Flight: # 2239
Swiss Flight: # 423, 423

Air France Flight: # 5705, 878
Continental sirfines Flight: # 43
Iberia Airlines Flight: # 7 , 975

=

11 Select Continental Airlines Flight: #4207.

The selected flight is shown under Travel Expenses.
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Travel Approval Application

.
 oeteit | cost=/8
We Continental Airlines Flight; # 4207 777.0

Submit Request  Delate rows ' Cancel Request TFT

12 Under Hotel Booking, open the drop-down list box.

Hotel Booking

Select a3 hotel |

HILTOM, 150

FOUR SEASONS,109
SHERATOMN, B2

WALDORF ASTORIA,250
RITZ CARLTOMN,200

EDEN ROCK,69

GRAND MERCURE ROXY,90
SOFITEL,125

HOLIDAY INM 66

13 Select HILTON,150.

The selected hotel is also shown under Travel Expenses, including the costs (7 nights * 150 =
1050). The total cost has also been updated (1827).

-
- oetedl 5] cest=|/Q
e Continental Aidines Flight: & 4207 777.0
£+ HILTOM 1050.0

Submit Request Delete rows cancel Request 1827

14 Choose the Submit Request button.

The Travel Expenses area is closed, and the My Travels area shows the travel details.
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Travel Approval Application

™
Iy Travels

|
= [Travel Detalls a
1l =

]

1827 €
= Departs: Feb 21, 2012 from Toronto,Canada by Continental Airinas Flight: # 4207
= Retum: Feb 28, 2012 from Beijing,China
1 HILTOM

At the bottom of the screen, you can see a message informing you that the travel request has
been accepted (pending approval), and that you can now either create a new request or log
out.

Adding Additional Expenses to Your Travel Request

You will now add additional expenses from a CSV file to your travel request. This is just for
demonstration purposes and you will delete these expenses before you log out.

~ To add additional expenses

1  Under Other Expenses, choose the Upload .csv button.

Ell:hlrr Expenses (C5Y file

x,_h Add other expenses from
= a .csv file,

Upload .csw

The File Upload dialog appears.

Sample Applications
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Travel Approval Application

/3 File Upload -- Webpage Dialog ES |

Eile Upload

| Browse...

Upload

2 Choose the Browse button.

3 Inthe resulting Choose File to Upload dialog, navigate to the location of your Eclipse work-
space. Here, you can find the project directory that has been created for your travel application.
The demo CSV file which comes with the travel application is located in the Expenses folder
of the project and has the name expenses_trip1.csv.

4  Select the file expenses_tripl.csv and choose the Open button.

The path to the selected file is shown in the File Upload dialog.
5  In the File Upload dialog, choose the Upload button.

The contents of the CSV file is shown under Travel Expenses.

iTravel Expenses -

|| Detail =
£# Misc. Food 150.0
57 Misc. Transport 350,0

Submit Request Delate rows Cancel Request 500

You will now delete the two items that were added from the CSV file.
6  Select both lines (press SHIFT or CTRL to select the second line).
7  Choose the Delete rows button.

8 Log out by clicking on the Log-out link which is located at the top right of the screen.

The logon screen containing the Please select a User name dialog is shown again.
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Travel Approval Application

Logging in as a Manager for Approving Travel Requests

In order to approve the travel request you have just entered, you will now log in as a manager.

To log in as a manager

1  Inthe Please select a User name dialog, open the drop-down list box and select the name
"ARCONADA PEDRO".

For this user, an Approve Requests button is shown which is only available to managers.

Please select a User name

A08 PEDRO W

i Approve Requests Eur; Enter Mew Requeast

2 Choose the Approve Requests button.

The following screen appears, listing the travel requests that are waiting for approval.

Friday, 4 Fabruary 2011 - 12:08 PM Wou're logged in as PEDRD ARCONADA Log-pat

U GITETER]  Travel Support System

‘Travel cost details = f =
lEmployee details; v F
Fame DAVID ADKTNSOM - SECRETARY (dept. MGMTL0 )
Address 11 HOLLY GREEMN

City CHAPEL HILL ’ 1
Country LS4 Tip Code 27514 -
[[[ravel details -
Travel Reason = (@ Total cost; 1827 [peg =] [Pie Chart =]
o =% Total costof flights: 777
. Members of staff - Requests status =
Approved &
DAVID ADKINSORN a i
Leaving Terorto,Canada Oon 2012-02-21
Traveling to Baifng, China Returning 2012-02-28
If you don't see the graphs, please install Adobe SV viewer or change the cutout format to JPeg
- .
g Submit approvad requests = .
: g
DAVID ADKINSON continental Arines FRght: # 4207 / HILTON | 1827.0

() Click a Travel Request row for details, DoubleClick to approve
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Travel Approval Application

Approving a Travel Request

After you have logged in as a manager, you can approve travel requests.

~ To approve a travel request

1 Under Department (MGMT) statistics, open the drop-down list box for the different types
of pie charts.

| Travel budget -

wavosdy uead
e b
ot vt kLl

[Ipeg =] [Pie Chart x|
Stacked Percent

30 Bar Chart —
iBie Chart

Pig Exploded Chart

| Members of staff -

DAVID ADKINSOMN

2 Select Pie Exploded Chart.
A different chart is shown, indicating the total travel budget that is available for the department,
and how much of the budget is currently requested.

3  Inthe table at the bottom left of the screen (below the Submit approved requests button),
double-click the row containing the employee name "DAVID ADKINSON".

A check mark is now shown in front of the row, and a message is shown at the bottom of the
screen informing you that you may submit the approved requests.
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Travel Approval Applicatio

n

4

5

" | . submit agproved requests |

-

=
" DAVID ADETNSON Continental Aifnes Flght: # 4207 / HILTOM / —amz7.0l

«  Wou may submit the approved requests

Choose the Submit approved requests button.

Use PDF icon for viewer or Printer icon to print the report

Approved Travels Report - Friday, 4 February 2011 - ;E

Travel request for DAVID ADKINSOMN

11 HOLLY GREEM

CHAPEL HILL NC , USA 27514

Travel Details

Departing From Toronto,Canada On 12-02-21
Returning From Beijing,China On 12-02-28

Travel Reason:

I have a series of meetings with customers regarding our
Detailed Expense Report:

Flight: Continental Airlines Flight: # 4207 - Price: 777
Hotel: HILTOMN - Price: 1050

Total cost of Trip: 1827

Fy

Click on the PDF icon (@) at the top right of the dialog.

The following dialog appears, containing the travel details for David Adkinson.

g | Webpage Dialog [E3

When appropriate PDF viewing software such as Adobe Reader is installed, the PDF output
is shown and you can print it.

Sample Applications
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5 Natural for Ajax Demos

= About the Natural for Ajax Demos ...
= |nstalling the Natural for Ajax Demos
= Starting the Natural for Ajax Demos
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Natural for Ajax Demos

About the Natural for Ajax Demos

The Natural for Ajax demos show you how to use the different controls and write the corresponding
Natural server-side processing. When you start one of the samples, a corresponding description
is shown which explains the sample and provides implementation hints.

Installing the Natural for Ajax Demos

Install the samples by clicking Natural for Ajax Demos on the welcome page. A new project named
"NaturalAjaxDemos" will then be shown in the Project Explorer view. See also Installing the
Sample Applications.

Starting the Natural for Ajax Demos

You can start the main program which lets you select single samples by executing the program
MENU-NJX.NSP.

You can also start single samples directly by executing the corresponding program, for example,
CALCUL-P.

28 Sample Applications



	Sample Applications
	Table of Contents
	Preface
	1 About this Documentation
	Document Conventions
	Online Information and Support
	Data Protection

	2 Installing the Sample Applications
	3 Hello World Application
	About the Sample Application
	Installing the Sample Application
	Starting the Sample Application

	4 Travel Approval Application
	About the Sample Application
	Prerequisites
	Installing the Sample Application
	Defining the Use of an External Web Browser
	Starting the Sample Application
	Logging in as an Employee for Requesting a Business Trip
	Entering a Travel Request with Flight and Hotel Information
	Adding Additional Expenses to Your Travel Request
	Logging in as a Manager for Approving Travel Requests
	Approving a Travel Request

	5 Natural for Ajax Demos
	About the Natural for Ajax Demos
	Installing the Natural for Ajax Demos
	Starting the Natural for Ajax Demos


